
 

 

Quick Guide to MagiCut V6 Pro 
 
 

 

Installation 

MagiCut V6 is supplied on a flash drive. This is required to install and then needs to 
be attached to the computer when running the program. 

 

MagiCut V6 requires  

• PC running Windows 2000, XP , Vista and Windows 7 (32 and 64 bit) 

• 1gb ram (2gb plus preferred)  

• 100gb hard disk minimum 

• 1 USB port for the FlashDrive 

• 1 USB port for a Printer if attached locally 

• 1 USB port or a serial Port for the Cutter 

• 1024 by 768 minimum screen resolution 
 

To install, place the flash drive in a free USB port. Open the flash drive in Explorer or 

My Computer and double click on the Launch.exe file. This will start the installation.  
Follow the prompts and MagiCut will be installed with entries in “All Programs” and 

an icon on the desktop (optional). 
 

For a USB connected cutter install the cutter driver from the manufacturer’s disks. For 

Graphtec cutters this requires the cutter to be in GPGL mode. Serial connections can 
use GPGL or HPGL. 

 

Note: Graphtecs are delivered currently in HPGL mode and will 

not work on USB. Change the language in the menus under 

Command to GPGL and set the step size to 0.025mm. 

First Run 

Start the program from the Desktop Icon or via All Programs – MagiCut – MagiCut 6 

Professional. On first startup a choose cutter dialogue will appear, select the cutter 
and connection. 

 
At any time it is possible to add and remove cutters using the “Manage Cutters” 

option in the file menu of MagiCut 6.  

 
Currently TheMagicTouch supplies Graphtec CE-5000-60 cutters. These can be used 

either via a Serial port (Normally COM1) or via USB.  Select the driver (GPGL or 
HPGL version as needed and set the cutter via its menus appropriately. 



 

 

MagiCut 6 
 

Settings  
Various settings are available in the View menu. This is where the program can be 

customised. 
 

View > Options item covers various program settings such as the Autosave,Backup 
fils, Undo memory size etc. 

 

 
 

View > Sheet properties menu covers the screen setting, page size, units etc. 

 

 
 
 



 

 

Quick Text 

 

 
 

To type some text, Open MagiCut and click on the A icon . In the toolbar that 

appears set the font required. Place the mouse pointer on screen click and hold the left 

button and drag vertically down the screen. This sets the text height. Release the 
mouse button and type your text. Arrow keys, backspace, delete etc. will work as a 

normal word processor. 

 

Option 
For an exact font size, set the text height in the box above “M” size then click once on 
the screen rather than dragging the mouse pointer down. 

 

To alter already typed text drag the mouse through the typed text to highlight all the 
letters then change options in the toolbar. (Control-A will also select all). To alter part 

of a text, drag through only the letter(s) to be altered. Shift + arrow key can be used to 
select as well. Place cursor in the line with the mouse, use the arrow key to move the 

cursor and shift +arrow to select a letter or letters. 

 

Kerning (letter spacing) 
 
Kerning is the distance between letters. Whilst not normally altered sometimes fonts 

contain bad settings for particular pairs or a special effect is called for. Another reason 

to alter spacing is when an outline is needed. 
 

To adjust the kerning of an individual pair select the letter before the gap then use the 
spin control to alter the gap, for more than one gap select the letters upto the gap to be 

altered. 

 

 
Here the W<>A and A<>V spacing will be altered. 



 

 

Quick Arc Text 
 

Type a line of text on the main screen, from the text menu select Put text on Arc. Set 
the method to fit the text, the default is Letter spacing. Options are Letter size, letter 

width and spacing. The Letter size option may be more useful than letter spacing. 

 
The line will appear on a half circle. To edit the arc press baseline adjust and 
manoeuvre the control points with the mouse.  You can place the lettering inside the 

arc with the side of arc button and reverse the direction with the direction one, used 
for the bottom of arcs. 

 

 

Press  icon to adjust the arc. The 

points ABCD will appear and the Arc 

ABC, clicking on point will draw a 
line from the centre D to the point.  

 
Point A and C alter the angle moving 

just the point, holding the shift key 

whilst moving A or C will move the 
two points in step. 

 
With the control key held, clicking on A B or C allows rotation of the text about D. 

 

Point B allows resizing of the arc and alters the radius as it is moved. 
 

After resizing there will probably be a need to resize the letters, alter word spacing, 
change the letter spacing. These can be done from the tool bar. 

 



 

 

Badges 
 
These are designs with text above and below. It can be done with Arc text but 

matching the parts can be difficult. As MagiCut will fit text to a line the easiest way is 
to place text on a drawn ellipse/circle. 

 

Start by drawing an ellipse from the shapes. Set its size to 
the badge size. Enter text mode and set the required text 

height. This can be altered later if needed, Set font and 
bring the cursor over the edge of the ellipse and click, the 

text cursor will attach to the ellipse. 

 
 

 
Start typing and the top part of the text will be placed on 

the ellipse.  

 
 

To align the text press the baseline adjust icon and 
move the pointers that appear at the start of the text 

with the mouse. 

 
 

 
 

 

Once the top is correct, bring the mouse pointer to the start point of the bottom 
lettering, Hold the Control key down and click the mouse button. The cursor will sit 

inside the shape. Type the text then use Ctrl-A to select all the text and alter the 
vertical displacement to -100% . The lettering will now hang off the base of the 

ellipse. 

 
 

 
 

 

 
 

 
 

 

 
 

It is possible to use vertical displace on the top text so all lettering is inside the ellipse. 
In this case you will need to alter the kerning value to space out the letters. 

 
 

 

 



 

 

Cutting 
Place material in cutter and initialise so it is ready to cut, set the cut pressure 
appropriate to the material.  

With the text on screen click the cut or cut selected icon  (or use File menu – 

Cut all/selected) 
 

The cut dialogue opens. For MagiCut 
Products (Flex, Flock etc.) the cut 

needs to be in mirror. 

 
Set Mirror on  - the E icon – press the 

Read button to discover the width of 
the material in the cutter. If the cut job 

fits then it will display correctly. If the 

cut is bigger than the read width a split 
line will appear. 

 
 

Assuming the object fits click the 

colours/markers tab. 
 

  
Here you can set the weed border and 

select to cut by colour or layer. 

 
Registration marks and Panel markers 

should be off.  
 

Weed border is optional, it makes it 

easier to weed when the cut object is 
only part of a sheet. For large objects 

it may be unnecessary.  
 

With the settings ready click the Cut 

tab. 
 

Here set the “Leave head at” to 1, ( 3 
is for roll cutting) a small value of 

overcut is helpful when weeding, a 

value of 0.3 to 0.4mm will do.  
 

Click start to cut. 
 

 

Remove waste (weed) and press on 
garment. 

 
 



 

 

Using templates 

 
For this example we’ll create a mouse mat. 

Start with a new screen. Import an image, probably a jpeg, rotate if needed then from 

the tools menu select Galleries, Clipart, hover the mouse over the templates (orange 
for CPM products, Blue for TTC)  until you see the message Mouse mat, drag the 

mouse mat onto the screen. The Mouse mat is correctly sized for printing. 
 

Switch the view mode to Coloured wireframe so you can see the relationship of the 

image to the template. Size the image so it fits correctly , just overlapping is best.  

 
 

Now return to the normal view, Drag a selection box over both the Image and the 

template, the  Icon will light up, Click it to add the template as a clip path to the 

image. The Mouse mat is now ready for printing. 



 

 

Printing 
 
Make sure the image is on the page. From the file menu select Print and the Print 

dialogue will appear. Check the scale is 100% and not greyed out. If the button by 
scale is pressed then the image is resized to fit the sheet.  

 
 

For Mouse mats and other TTC and CPM printed products the print normally needs to 

be mirrored. This is set in the lower left. Centre the image using the placement option. 
Click print setup and set the correct paper type for TTC on the printer, for example 

OKI printers generally use TTC3.1 A4R running as Heavy. 
 

Print the TTC and press on the Mouse mat.  

 
Templates are provided for many TheMagicTouch products for use with CPM and 

TTC. The templates when hovered over provide basic pressing instructions to help 
with creating the product. 

 

 
Here is the extended information on the Mousemat 

as an example. 
 

  

 
 

 
 

 

 
 

 
 

 



 

 

WoW 

 
WoW 7.1 is a unique (and patented) method of producing coloured images on dark 

(and light) garments without a background and without needing to use a cutter. 

 
Creating patterned text for WoW 7.1 

 
Start by typing some text then open the Fill gallery from the tools menu – gallery – 

Fills. 

 
 

Drag the required fill from the fill gallery, a simple mouse drag will fill a single letter, 
to fill the entire word(s) hold the shift key down and drag. The example has the 

oranges dragged with the shift key then the strawberry dragged over without the shift 

key to fill a single letter. 
 

The fill can be modified by using the fill mode option. Click the  icon to enter fill 
mode. 

 
The fill tools will only work on a single fill, not a mixed fill object. So here the fill is 

dragged over with the shift held down, in fill mode an adjustment tool appears. The 

arrows can be stretched and angle altered, this changes the size and skew of the 
image. 

 
 



 

 

Printing for WoW 
 
   

From the file menu choose print. 
WoW requires two prints, a mask 

and a coloured image. The mask 

is printed onto plain (100gsm) 
paper. 

To print the mask select 
placement and centre the image 

use optimal layout in the bottom 

left to fit as many images on the 
paper as possible. Then places 

ticks in the Mirror and Mask 
boxes. The position of the corner 

cutout can be selected in the 

corner options, this cutout is to 
make peeling easier. 

 
Use print setup to select the correct paper settings and print the mask. 

 

Turn off the Mask option,  
leaving mirror on,  Use print 

setup to set for the I sheet and 
print the I sheet 

 

The prints are now ready for 
making the WoW transfer. 

 
 

 

  
 

 
 

 

The same technique works with any drawn or scanned and converted shape. 
 

For Shapes with photographs the shape must be added as a clip path to the photograph 
similar to the method described in the mouse mat explanation.  



 

 

Simple Tracing 
 
MagiCut is capable of tracing a bitmap image and producing a vector output for 

cutting. 
 

Import a bitmap – tif bmp jpg etc, best results from high resolution monochrome 

images such as TIF and BMP, jpegs tend to give scruffy edges due to the lossy 
compression  used. 

 
 

 

 
 

Right Click the image and select trace mode 
 

 

 
 

 

Trace toolbar 
 

 
With the trace on Default settings click on the 

trace icon, press the Show nodes to see the 

trace. 
 

Provided this is acceptable, return to the 
normal mode with the white arrow ( Selection 

mode) 

 

In wireframe you can see how the trace 
is. This is now a resizable and cutable 

object. 

 
 

 
 

 



 

 

Basic Print and Cut  
 

To print then cut an object / image it needs a path round the edge with a Print&Cut 
Property. The edge may be put on with add clippath for images or simply selected for 

a vector object. 

 

Adding a clippath to an image . 
 
Place shape over image – Drawn shape, text, 

traced object etc. and with both selected click 

the add clippath icon. 
 

To edit the clippath right click the object and 
selec the edit clippath, change with the node 

tools for example then right click again and 

choose the edit clippath menu item again to put 
it back on the image. 

 
 

 

 
With a path available, select  from the tools menu 

“Print and Cut”  this brings up the print and cut 
dialogue. 

 

For a straight forward print and cut set . 
Outline – cuts outside the edge, depends on Distance 

Outermost contour – will not cut any inner parts 
Background colour – set on for a bleed 

Bleed distance- 1mm to stop wisps of white 

 Bleed inside - 0.25mm can cover trace errors on jpeg 
edges  

 
Normally Outline at 0mm unless a stepped of cut is 

needed.  Inline can be used to cut inside the image, can 

be good on photographs. 
 

 
With this set and a correctly sized object. Start the print options – File Print. 

 

Various settings need to be done, including setting the marker options for the cutter, 
the print media type, paper margins and triggering the Print Cut mode. 

 



 

 

Start with an Image, Add a shape and then select both to Add the clippath 

 
 
This gives the shape,  Now use the print 

and cut option from the tools menu and 
sett the required options – 

 

Distance 0 
Outermost contour 

Background colour (red to display here) 
Bleed inside 

And click apply 

 
The item is now ready for print and cut 

 
Enter print mode (File> Print) 

 

First setup the printer (1) by 
clicking print setup and selecting 

printer and paper size and media 
type (OKI 5750 and OBM select 

OBM or Labels1)  

 
Next setup the margins under the 

paper tab (2)  
 

Then set the print and cut options 

(3) 
 

Press Optimal setup to see how 
many Magicut can fit in the 

margins (4) and finally press the 

Print with cut icon  to enable the 
cut option. 

 
The next section describes the actual settings starting at 2 as the print setup is printer 

specific. 

 
 

 
 



 

 

2 Paper 
 

This sets the margins MagiCut 
uses to leave unprinted area for 

the cutter. 

 
For a Graphtec cutter the 

margins when cutting without 
using a backing sheet are  

12mm top, 12mm left and right 

and 45m bottom. This gives 
room for the wheels and 

prevents the paper falling out 
of the cutter. 

 

With a backing sheet all 
margins may be reduced to 

6mm  as the wheels can run on 
the backing. 

 

3 Print and cut options 
 

This sets the size and thickness of the 
markers along with a guard distance to keep 

the image out of the marker area.  

 
Suitable settings for a Graphtec are size 

10mm, line width 0.5mm, the distance 
depends on the image, 0mm is suitable for 

images which do not project into the 

markers, a maximum of 10mm is needed for 
the worst shapes to prevent the optical eye 

picking them up  
 

Graphtec’s use a tri-marker system which 

needs to be on. The cutter also needs to be 
set correctly for print and cut 

 
 

4 Optimal Layout 
 
Press to see how many fit. This can be 

altered with the rows and columns and the 
space modified if needed 

 
 

5 Press the Print with Cut icon. 
 
Insert paper in printer and press the print 

icon



 

 

Cutting the printed material 
 

Take the print and place in the cutter. In the case of the Graphtec cutter make sure the 
markers are correctly positioned, the righthand one as you look at the cutter is the 

most important and needs a gap of 2mm or so from the inside of tyre and no further 

forward then the cutting line.  
 

The positioning is similar with a backing sheet except there is less need to worry 
about the left side 

interfering with the 

markers. 
 

Do not forget if you 
print landscape to put in 

the cutter landscape! 

 
 

The image shows paper 
on a backing sheet in 

both landscape and 

portrait positions. The 
position of the marker 

can be seen. 
 

Without a backing sheet 

the position is the same 
with wheels on each 

edge and the markers 
between the wheels. 

 

 
 

 
 

With the paper positioned 

click on the cut tab. 
 

Show non cutting part allows 
a quick check you have got 

the correct lines – Clicking 

this  turns off the fill and 
displays only those parts 

tagged as Print&Cut. 
 

 
Calibrate cutter starts the 

marker calibration process. 

 
 

 



 

 

Calibrate cutter 
 
Press the Calibrate cutter 

button and the Calibrate 
dialogue appears. 

 

Assuming the Graphtec cutter 
is ready – Paper loaded and 

initialised  usually with roll 2. 
 

Press the Automatic Calibration 

button, a dialog pops up on screen 
saying Press OK to read back 

Coordinates 
 

Wait! For the cutter to measure all 

three points and return to the 
origin. Then press the OK 

 
The three lines saying Undefined 

in the first image will fill in with numbers – these are the co-ordinates of the markers. 

 
Press OK on the Calibration dialogue then press the Cut button. 

 
Finished!  

 


